Generic RSE User's Guide

Version 3 Release 1
Note

Before using this information, be sure to read the general information under “Notices” on page 37.

Second edition (September, 2016)

This edition applies to IBM Explorer for z/OS Version 3.0.1 (program number 5655-EX1) and to all subsequent releases and modifications until otherwise indicated in new editions.

© Copyright IBM Corporation 2016.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
About this document

This document discusses RSE usage that is applicable to various platforms. It includes instructions on RSE connections, RSE filters, profiles and search. For the usage of RSE for z/OS®, see RSE for z/OS User’s Guide (SC27-8433).

The following names are used in this manual:
• IBM® Explorer for z/OS is called z/OS Explorer.
• Remote System Explorer is called RSE.
• z/OS UNIX System Services is called z/OS UNIX.

This document is part of a set of documents that describe the usage of z/OS Explorer. Each of these documents has a specific target audience. You do not have to read all of these documents to complete the z/OS Explorer usage.
• IBM Explorer for z/OS User’s Guide (SC27-8431) describes in detail all of non-RSE perspectives, views, and tasks.
• Generic RSE User’s Guide (SC27-8432) describes filters, profiles, shells and commands, and search of RSE.
• RSE for z/OS User’s Guide (SC27-8433) describes usage of RSE on z/OS systems.

This document is maintained between product releases. The new changes, and smaller corrections and additions, are indicated by a “|” change bar in the left margin of the page.

Who should read this book

This document is intended for developers and system programmers who are using any of the products in the IBM Explorer for z/OS family. The IBM Explorer for z/OS provides access to basic z/OS resources and functions. IBM Explorer for z/OS also provides a workbench that can be used to install additional compatible Eclipse-based products to provide a powerful platform to access z/OS subsystems and develop and debug z/OS applications.
Chapter 1. Getting Started with the Remote System Explorer

The Remote System Explorer (RSE) is a perspective and toolkit in Eclipse Workbench, that allows you to connect and work with a variety of remote systems. With the predefined plug-ins, You can look at remote file systems, transfer files between hosts, do remote search, execute commands and work with processes.

Additional capabilities may be added by Software Vendors by providing new System Types, Services and Subsystem implementations for specific remote access protocols or resource kinds respectively. The framework helps by providing lots of predefined re-usable components, like persistence mechanisms, filtering and team sharing.

This tutorial will guide you quickly through the most prominent features of the Remote System Explorer:

- Installing the Remote System Explorer
- First Steps with the Remote System Explorer
- Using Remote System Explorer Connections
- Extending Remote System Explorer

Related concepts

Remote System Explorer Connections

Installing the Remote System Explorer

The simplest way to get RSE is via Software Updates: From your running instance of Eclipse 3.4 or newer, choose Help > Install New Software.... to open the software installation wizard.

In case an update site is not pre-configured, consult the Eclipse TM Homepage for finding the latest update site to use, or enable an Eclipse Release Train Repository, like the http://download.eclipse.org/releases/indigo repository for Eclipse 3.7 (June 2011). Type "Remote" in the filter box and press ENTER to find the RSE downloads; for the stand-alone Terminal view, find "Terminal". Select what you want to install and finish the wizard.

If you prefer manual installation, you can download RSE SDK from the Target Management Download Site and extract it into the dropins folder of Eclipse 3.4 or later, or link it as product extension.

Start Eclipse Workbench, and choose Window > Open Perspective > Other > Remote System Explorer.

Follow-up tasks

First Steps with the Remote System Explorer
Connecting to a remote Linux or UNIX server
Connecting to a remote Windows server
Using Remote System Explorer Connections
Extending Remote System Explorer
First Steps with the Remote System Explorer

Even without an actual connection to a remote system, you can start experimenting with the Remote System Explorer UI on the local host, which is shown by default under the Local node:

- Browse the Filesystem, choose contextmenu > show in Table, and observe the Properties view.
- Create a new Filter to show specific resources in the file system only.
- Launch an RSE Shell (Shells node > Launch)
  - In the Shell, perform commands such as ls, dir, ps, gcc, make and see the output interpreted
  - Use Ctrl+Space Content Assist on the shell command entry field

For operations on an actual remote system, you can either

- use the "SSH Only" system type (New > Other > Remote System Explorer > Connection), or
- start a dstore server daemon on the remote system and use any of the other connection types.

RSE is a framework that supports plugging in many different communication protocols. By default, the dstore, FTP and ssh protocol plug-ins are provided, with dstore being the richest in features.

DStore requires a server to run on the remote system. There are several methods to get a server launched for a particular user, the most easy one to set up is the daemon method.

Follow-up tasks

- Connecting to a remote Linux or UNIX server
- Connecting to a remote Windows server
- Using Remote System Explorer Connections
- Extending Remote System Explorer

Related concepts

- Remote System Explorer Connections
- Remote System Explorer filters, filter pools, and filter pool references
- Universal Systems

Setting up a dstore server

There are two separate platform families on which you can run a dstore server: the Linux/UNIX family and the Windows family. Each is set up a bit differently. Follow the link to the platform of your choice.

- Connecting to a remote Linux or UNIX server
- Connecting to a remote Windows server

Using Remote Connections

Here are a few tasks that help you get acquainted with RSE. All tasks assume that you have switched to the Remote System Explorer Perspective in your Workbench. Some of the tasks can not be performed on all system types, although RSE tries to provide a consistent UI across many different kinds of remote systems.
In the RSE Perspective, Remote Systems View, press the **New Connection** button.
- Note: In the Preferences, you can enable displaying available new connection types in the RSE tree.

Select the desired system type
- Choose system type "SSH Only" for ssh servers, or any other for dstore.

Enter an IP address for a remote system running an ssh server or dstore server. A connection name will be suggested automatically, but can be changed.
- You can also run a dstore server on the local machine for testing. In this case, type "localhost" as address.
- You can press Finish right away, the wizard defaults are usually fine.

Fill in the username / password dialog.
- Note: For ssh, if you have private keys, the password here is just a dummy. Enter anything and save it. You can setup ssh private key authentication through the **Team > CVS > SSH2 Connection Method** Preference page.

Browse remote files, or open remote shells.
- You can drag and drop files between local and remote file systems, between editors and any view. Files are transferred as needed.
- On dstore, you can browse into remote archives (*.zip, *.tar) without having to transfer the entire contents. This works thanks to "miners" on the remote side. Custom miners can be plugged into the dstore server.
- On dstore, you can choose **Search > Remote...**.
  - The dstore miners support searching a remote file system without having to transfer any data.

On dstore, when the remote system is Linux, AIX® or Other Unix:
- Browse remote **Processes**.
- Select "My Processes" and choose context menu > **Monitor**.
- Enable polling, choose a short wait time. See processes appear and vanish as you perform commands in a remote shell.

**Follow-up tasks**

Extending Remote System Explorer

**Related concepts**

Remote System Explorer Connections
Remote System Explorer filters, filter pools, and filter pool references
Shells and commands in the Remote Systems view

**Related tasks**

Copying and pasting in the Remote System Explorer
Running and viewing commands using the Remote Shell view
Working with command shells
Search for text and files on remote servers
Extending Remote System Explorer

There are numerous ways how developers and software vendors can extend the capabilities of the Remote System Explorer. Please look at the RSE Developer Guide to learn about adding subsystems, remote property pages or additional popup actions. The developer guide holds extensive tutorials, overview documentation and reference.

Users can configure and customize the Remote System Explorer through Preferences and connection setup.

Related concepts

Remote System Explorer filters, filter pools, and filter pool references
Chapter 2. Remote System Explorer Connections

When you first open the Remote System Explorer, you are not connected to any system except your local workstation. To connect to a remote server, you need to define a connection. A connection is a TCP/IP network connection to your server, that enables you to access, edit, run, compile, and debug items on the server. When you define a connection, you select the type of connection you want, specify the name or IP address of the remote system and you also give the connection itself a unique name that acts as a label in your workspace so that you can easily connect and disconnect. These actions are performed in the Remote System Explorer.

When you open the workbench for the first time, you need to define a profile, define a connection, and then connect to a server. When you connect, the workbench prompts you for your user ID and password on that server so that you can access the folders and files on that server.

Note: Make sure you have started the server programs on your remote system. These programs depend on the kind of system you are connecting to. See the appropriate tasks below for the recommended ways to configure and start your server.

When you have a connection, you can organize your data using filters, filter pools, and filter pool references, which list a set of folders and files from your server in the Remote Systems view.

You can use the Remote System Explorer to access files on many kinds of servers, such as Linux, UNIX, Windows, or your local workstation. See the links below for information on how to connect to these other kinds of servers.

Related concepts

Remote System Explorer filters, filter pools, and filter pool references
Remote System Explorer Profiles
Universal Systems

Related tasks

Connecting to a remote Linux or UNIX server
Connecting to a remote Windows server

Universal Systems

At a minimum the Remote System Explorer provides access to Linux, UNIX, and Windows systems. These are called "universal" systems since their file and command systems are quite similar. You can export, import, explore remote files, and run remote commands on all of these system types. You can also drag/drop and copy/paste between two systems of the same or different type. For example, you can drag and drop a file from your Windows host to your Linux host, from one Linux host to another, or from one file in your Linux host to another file in the same host.
The Remote System Explorer can also provide access to other types of systems if the support is installed in the workbench. Examples of such systems might be IBM iSeries or zSeries server systems.

Expand the topics in the help contents or click the following links for information on Universal host access:

**Related concepts**

Shells and commands in the Remote Systems view

**Related tasks**

Connecting to a remote Linux or UNIX server
Connecting to a remote Windows server
Creating a second connection to a remote host
Deleting a connection
Disconnecting from a remote host
Copying and pasting in the Remote System Explorer
Dragging and dropping items in the Remote System Explorer
Configuring environment variable support for connections

## Connecting to a remote Linux or UNIX server

The following documentation explains how to install the Linux or UNIX server code, start the server daemon, and make a connection to a remote Linux or UNIX server. Look here for setting up a server on Windows.

### Prerequisites

To use the Remote System Explorer communications server daemon you need to install Perl. Using the daemon helps eliminate some of the manual steps when you connect to the server.

### Installing the server code

1. Find the package that contains the server. The server code is usually packaged with the containing product and you should refer to that product's documentation for finding and installing the server package. The server is also available, however, on the Eclipse Target Management download site as the package `reserver-<version>-<os>.tar`. For example, `reserver-2.0-linux.tar` contains the release 2.0 server for Linux. There are servers for Linux, AIX, a generic Unix version that can be tailored to your particular flavor of Unix, and an experimental Mac OS X version.

2. Ensure that Perl is installed.

3. Ensure that a Java™ Runtime Environment (JRE) version 1.4 or higher is installed. An IBM, Oracle or equivalent JRE is required; The gcj-based jvm shipped with most Linux distributions does not work. In doubt, run the command `java -version` (see below) and check if there is a reference to gcj. You can download an Oracle JRE from [http://www.oracle.com/technetwork/java/](http://www.oracle.com/technetwork/java/)

4. Create a directory where you want to install the server code. The remainder of these instructions will assume the directory `/opt/rserver` (suitable for team sharing), but you are free to use any directory.

5. Upload the server package to this directory. You can use FTP.
6. Switch to the /opt/rseserver directory by typing:
   
   cd /opt/rseserver

7. Run the following command in the /opt/rseserver directory to extract the server code from the package appropriate to your operating system. For Linux, this command is:

   tar -xf rseserver-2.0-linux.tar

**Starting the server**

You can start the RSE communications server with the server daemon, or manually. Before starting the server, make sure the Java command is in your path, you can do this by running the following command:

   java -version

You should see something similar to the following:

   java version "1.4.1"
   Java(TM) 2 Runtime Environment, Standard Edition (build 1.4.1)
   Classic VM (build 1.4.1, J2RE 1.4.1 IBM build cxpc32141-20040301 (JIT enabled: jitc))

If you receive a "command not found" error, then try creating a symbolic link to the java command in /usr/bin by running the following command:

   ln -s /opt/IBMJava2-141/jre/bin/java /usr/bin/java

**To start the server with the server daemon**

1. Ensure that you are running using the root user ID. (If the daemon is not run under root, it will be unable to authenticate connecting users.) Run the following commands:

   su -l root
   cd /opt/rseserver
   perl ./daemon.pl [daemonPort] [serverPortRange]

Note that the server daemon runs on port 4075 by default. You can pass the optional daemonPort argument to force a different port if you want. If your daemon runs behind a firewall, you may want to specify the optional serverPortRange argument to restrict selected server ports to the range given:

   perl ./daemon.pl 4075 10000-10010

**To start the server manually**

*Note:* In the following discussion we assume that the RSE server has been installed on Linux. If you are running on a UNIX system the script name is "server.sh" rather than "server.pl".

If you do not have root access on a remote machine, you can start the server manually for your particular user id only. Run the following commands:

   cd /opt/rseserver
   perl ./server.pl [port]

These commands run the server.pl script located in the /opt/rseserver directory. The port parameter to the server.pl script is optional. If you do not specify a port, then the server will pick the first one available and print the port number to standard out. By default, it is usually 4033. If you would like to use a different port, you will then have to enter this port number in port property for the Files subsystem for your connection in the Remote System Explorer (see Connecting to the Remote Server, below). Otherwise, you do not need to change this property.
Note: When you connect RSE to the server, the server will terminate as soon as you disconnect the client. The daemon, however, will not terminate.

Rexec Server Launcher

If you have Rexec access enabled to your remote system, you can also have the server started automatically by an Rexec command from the client, when you connect. To do so, use the Server Launcher Properties in the New Connection Wizard.

Running the daemon at startup

You might instead want to configure the daemon to run at start up for Linux. To do so, you need to append a call to the daemon to your startup script. Add the following lines to the bottom of the /etc/rc.d/rc.local file:

```
cd /opt/rseserver
perl ./daemon.pl &
```

SSL Encryption and Firewalls

By default the RSE DStore connection is unencrypted. You can, however, configure it to use SSL encryption.

Because all dstore data transfer is done through a single TCP/IP connection, the connection can also be tunneled through an ssh channel. In fact, the same ssh channel can also be used to start the server, like in the following example:

```
ssh -l moberhuber build.eclipse.org -L27127:build.eclipse.org:27127 "sh -c 'cd ~;/rseserver/latest; perl ./server.pl 27127'"
```

Here, the RSE Server is started on port 27127 through an ssh connection, and at the same time port 27127 is forwarded through ssh to the local host. You can now connect RSE to localhost: 27127, and the connection will transparently be forwarded to the remote system.

Connecting to the Remote Server

To make a connection to your remote server:

2. In the Remote Systems view, New Connection is automatically expanded to show the various remote systems you can connect to through the Remote System Explorer. Expand Linux or Unix to invoke the new connection dialog box and configure a connection.
3. Enter a name for your first profile and click Next. (This step only occurs if you have never defined a connection before.)
4. Enter a connection name. This name displays in your tree view and must be unique to the profile.
5. Enter the name or TCP/IP address of your Linux server in the Host name field, for example, LINUX_A.
6. (Optional) Enter a Description. The description appears in the Properties view after the connection is created.
7. Click Finish to define your system.
Attention: To check your port number, right-click your connection or subsystem from the Remote Systems view and select Properties. Click Subsystem to view the relevant information. If your port is “0,” then your Remote System Explorer communications server will pick any free port on the server. If you specified a port number when starting the server, you need to enter it here, for example, to work with a firewall.

Related tasks

Connecting to a remote Windows server

The following documentation explains how to install the Windows server code, start the server daemon, and make a connection to a remote Windows server. Look here for setting up a server on Linux, General UNIX or Mac and additional configuration options.

Installing the server code

1. Create a directory where you want to install the server code. The remainder of these instructions will assume the directory name and location is C:\rseserver, but you are free to use any directory you choose.
2. Find the package that contains the server. The server code is usually packaged with a containing product and you should refer to that product’s documentation for finding and installing the server package. The server is also available, however, on the Eclipse Target Management download site as the package rseserver-<version>-<os>.zip. For example, rseserver-2.0-windows.zip contains the release 2.0 server for Windows.
3. Copy the rseserver.zip to the C:\rseserver directory (this could be on a different machine).
4. Using an unzip utility to extract the server code to the C:\rseserver directory.

Starting the server

You can start the RSE communications server with the server manually, or with a daemon.

To start the server with a the server daemon:

1. Simply double click the daemon.bat program to start a server daemon.
2. You can edit the daemon.bat file to change properties for the daemon, like a specific daemon port to use or to force a port range for the server (in order to comply with firewalls).

Note that the server daemon does not enforce any user authentication. If you run the server daemon, any user can connect to the machine, work with the file system and run commands. Use of the server daemon on Windows systems is not recommended.

The server daemon runs on port 4075 by default. You can pass the optional daemonPort argument to force a different port if you want.
If your daemon runs behind a firewall, you may want to specify the optional serverPortRange argument to restrict selected server ports to the range given:
daemon.bat 4075 10000-10010
To start the server manually:
1. Simply double click on the server.bat program to start a dstore server. The server will pick the first port available and print the port number. By default, it is usually 4033. You will then have to enter this port number in port property for the Files subsystem for your connection in the Remote System Explorer.
2. For security reasons, the server will only wait a limited time until a client connects (12000 seconds by default).
3. In order to start the server with an exactly specified port or timeout, open a Windows command prompt and enter:
   ```
c: cd \rserver
server.bat [port] [timeout]
```
4. When you connect RSE to the server, the server will terminate as soon as you disconnect the client. The daemon, however, will not terminate.

To connect to a remote Windows server:
1. Switch to the Remote System Explorer perspective.
2. In the Remote Systems view, New Connection is automatically be expanded to show the various remote systems you can connect to through the Remote System Explorer. Expand Windows to invoke a dialog and configure a connection.
3. Enter a name for your first profile and click Next. (This step only occurs if you have never defined a connection before.)
4. Enter a connection name. This name displays in your tree view and must be unique to the profile.
5. Enter the name or TCP/IP address of your Windows server in the Host Name field, for example, jsandler.
6. Enter a Description (optional); the description appears in the Properties view after the connection is created.
7. Click Finish to define your system.

Note: To check your port number, right-click your connection or subsystem from the Remote Systems view and select Properties. Click Subsystem to see the relevant information. If your port is “0,” then your Remote System Explorer communications server will pick any free port on the Windows server. If you specified a port number when starting the server, you need to enter it here, for example, to work with a firewall.

Related tasks

Connecting to a remote Linux or UNIX server

Disconnecting from a remote server

To disconnect from a remote server in the Remote Systems view, right-click one of the subsystems displayed under your connection name and select Disconnect, or close the workbench.

If you choose to close the workbench in order to disconnect, it notifies you of any outstanding communications requests. However, any tools launched from the
workbench that run externally from the Remote System Explorer communications server, such as an external remote editor, are not affected because they have their own communication connection.

You can monitor and change the properties of your connection in the Properties view of the Remote System Explorer perspective. Some values are read-only, and you can change others, such as the description or the server name. Although each Remote System Explorer subsystem maintains its own list of properties, three properties (connected or disconnected, port, and user ID) are shared among all subsystems. If you change any of these properties in one subsystem, the other subsystems reflect the change.

Select a subsystem and check the Properties view to see the shared properties for all of your subsystems. For example, the Connected value is Yes or No for all of your subsystems under one connection. If you have difficulties connecting and disconnecting from the server, see the related link for troubleshooting information.

**Related tasks**

Deleting a connection

Creating a second connection to a remote server

In the Remote System Explorer, you can create a second connection to the same, or a different type of server, such as Linux, UNIX, or Windows. You can also create a second connection to the same server with a separate job environment, for example, to specify different environment variables or different user IDs.

To create a second connection:
1. In the Remote Systems view, expand **New Connection**.
2. Click the plus sign beside the type of server you to which you want to make a second connection. For example, Linux, UNIX, or Windows.
3. Complete the dialog as you normally would, making sure that you give your new connection a unique name.

**Related tasks**

 Configuring environment variable support for connections
 Connecting to a remote Linux or UNIX server
 Connecting to a remote Windows server

Deleting a connection

Deleting a connection to a remote server does not delete any elements on the server. The action deletes your specific configuration for that connection, including your filters, filter pools, user actions, compile actions, saved commands, and named types.

To delete a connection, in the Remote Systems view, right-click your connection and select **Delete**.

**Related tasks**

Disconnecting from a remote server
Configuring environment variable support for connections

Environment variables are set for the remote job process when you first connect to a remote system. This means that the results of setting the variables are shown in the Remote Shell view. If the system type you are using is case sensitive (UNIX for example), then the environment variables will also be case sensitive. Spaces and equals signs ( = ) are only allowed in the value for the environment variable, not in its name.

You can define environment variables for all Remote System Explorer connection types that support them (Windows, Linux, UNIX, and other system types that are installed).

If you change an environment variable while the Remote System Explorer is connected to a remote server, the change does not take affect until you disconnect and reconnect.

Although environment variables are set in subsystem properties pages, the Remote System Explorer stores them globally by connection.

If you need to specify different environment variables or user IDs for a particular remote system, you can do so by defining multiple connections to that remote system and then defining the environment variables on the file subsystem for each connection.

To configure environment variables:
1. Create a connection to a server if necessary.
2. Expand your connection name in the Remote Systems view.
3. Right-click on a file subsystem and select Properties.
4. Click Environment Variables and configure the variables as needed.
   - To add an environment variable, click Add. Enter a name and value for this variable, and click OK.
   - To change an environment variable, select the variable in the table and modify the name or value directly. To use a dialog box, select the variable and click Change. The name and value of the current variable are pre-filled in the dialog box. Overwrite whichever field you want to change and click OK.
   - To remove a variable, click the variable to select it and click Remove.
   - To move a variable up in the list, click the variable to select it and click Move up.
   - To move a variable down in the list, click the variable to select it and click Move down.
Chapter 3. Filters, filter pools, and filter pool references

Filters and Filtering Resources

The Remote System Explorer is a set of local client tools you use to organize how you want to work with the resources such as folders and files on your remote server. The following graphic serves as an introduction to some of the main components of the Remote System Explorer:

In the Remote System Explorer perspective, you query your server to list and perform actions upon remote resources such as folders and files. You perform these tasks on these remote resources by using filters that show these resources at your workstation.

The Remote System Explorer perspective is designed to allow you to manipulate the resources directly on the remote system. The actions that are available depend on the type of system you are connecting to and the way the resource is recognized. For example, your selections can define a filter string to find all files that match *.c in a particular directory.

Filters, then, reveal resources on the remote system. The types of resources they reveal depend on the subsystem you are viewing. A file subsystem, for example, reveals files and directories on the remote system. A process subsystem will reveal running processes.
File subsystems are quite rich in their function. For example, you can copy files and folders between remote systems regardless of the type of connection you have to those remote systems. Just a quick note: if a directory is revealed by a filter, copying that directory to a remote system will result in all the files in that folder being copied, not just those that are revealed by the filter. This is consistent with the way resources are managed elsewhere in Eclipse.

**Filter Pools**

If you have been using the Remote System Explorer for some time, your workspace might contain too many filters to navigate easily. Or, you might just want to keep groups of filters separate if, for example, you need to represent two distinct environments in the Remote System Explorer, regardless of how many filters you have. In either case, you can group filters into *filter pools*.

For example, one filter pool could contain filters for an accounts receivable program while another contains filters for a payroll program. Or, if you have two different environments on your server: a production environment and a test environment, you can define a distinct environment and set of filters for each.

Without filter pools, all of your filters appear together in all connections. When you create filter pools, however, any filter you create within that filter pool is distinct to that connection, and will not appear in any other connections. (See the related links for more information about filter pools.)

**Note:** at time this filter pool names cannot contain three consecutive underscore characters.

**Sharing Filters**

You can share filter pools among many connections through the use of a *filter pool reference*. A filter pool reference is a mechanism that displays a filter pool from one connection in any other connection, so that when you make a change to the original filter pool, your change is reflected in your filter pool reference.

All connections, filters, filter pools, and so on, belong to a Remote System Explorer *profile*, that you define during your first connection to a server. You might wonder what happens to your filters or filter pools if you delete a connection, especially if you have filters shared among two or more connections. Rest assured that the filters are not deleted, since filters actually belong to profiles, and not connections.

Keep in mind that if you need to have an entirely new configuration of filter pools, filters and connection in the Remote System Explorer, you can always create a new profile. See the related links for more information.

**Related Tasks**

- [Configuring filter pools](#)
- [Changing filters](#)
- [Deleting filters](#)
- [Creating a second profile](#)
Creating file filters

File filters list a set of files and folders from your host in the Remote Systems view.

1. In the Remote Systems view, expand your connection and then expand Files.
2. Right-click Files, or your filter pool, and select New > Filter.
3. Browse, specify, or select from the Fold drop-down list the folder that contains the appropriate files and folders.
4. Enter a generic or specific file name in the File name filter field. The default is * (asterisk). You can, for example, enter s* to list all files that start with s.
5. (Optional) To select a specific file type, enter the type in the File types field, or click Select to select from all known file types.
6. Use the Show files only check box to select whether you want to list only files.
7. Click Next.
8. Enter a name for your filter and select the profile that you want to use. Use an individually created profile to keep your work private, or select the Team profile to share with others. Note: Filters are named so that the Remote System Explorer can save them for future use.
9. Click Next to see more text information about the filter or click Finish.

Your new file filter is displayed in the Remote Systems view under Files.

Related tasks
- "Changing and renaming filters"
- "Configuring filter pools" on page 16

Changing and renaming filters

You can change or rename a filter if you want to alter the host items that it displays in the Remote Systems view. When you change a filter, you can also add extra conditions to what is filtered. For example, if you have a filter that displays all files of type *.c, you may also want to add an additional filter string that will display files of type *.h also. To change or rename a filter:

1. In the Remote Systems view, expand your connection name, and then expand Files to see a list of filters.
2. Right-click the filter and select Properties.
3. In the properties window, select the Filter Strings category and do the following actions:
   • Edit the conditions that are filtered and click Apply. If you want to add extra conditions, as described in the introduction to this topic, click New filter string and complete the dialog. Click Create.
   • Modify the name of the filter.
4. Click OK.

Deleting filters

Deleting a filter does not delete any elements that you managed with that filter. The action only deletes your specific configuration for that filter. To delete a filter:

1. In the Remote Systems view, expand your connection, and then expand Files.
2. Right-click your filer and select Delete.
Configuring filter pools

If you have been using the Remote System Explorer for some time, your workspace might contain too many filters to navigate easily. Or, you might just want to keep groups of filters separate if, for example, you need to represent two distinct server environments in the Remote System Explorer, regardless of how many filters you have. In either case, you can group filters into filter pools.

All filters live in filter pools, but these remain hidden unless you choose to manage them explicitly. If you do not manage them yourself the Remote System Explorer manages them for you and all of your filters appear together in all connections. When you create filter pools, however, any filter you create within that filter pool is only present in connections that reference that filter pool, and will not appear in any other connections. (See the related links for more information about filter pools.)

To illustrate the use of filter pools,

1. Click the menu button on the toolbar for the Remote Systems view, and select Show Filter Pools.
2. Expand the Local system and the Local Files subsystem, and you can now see your filters listed under Connection name Filter Pool.
3. Right-click Local Files and select New > Filter Pool.
4. Enter a pool name and click Finish. (You do not need to change your profile selection.) Your new filter pool displays underneath your connection.
5. Right-click your new filter pool and select New > Filter.
6. Complete the wizards as you normally would (see related tasks). When you are finished, you can see your new filters displayed in your new filter pool.

If you decide not to see the filter pools anymore, click the menu button on the toolbar for the Remote Systems view, and select Show Filter Pools again to deselect the check mark.

Note: at time this filter pool names cannot contain three consecutive underscore characters.

Related concepts
Remote System Explorer filters, filter pools, and filter pool references

Configuring filter pool references

You can share filter pools among many connections through the use of a filter pool reference. A filter pool reference is a mechanism that displays a filter pool from one connection in any other connection, so that when you make a change to the original filter pool, your change is reflected your filter pool reference.

Before you create a filter pool reference, ensure that you have already completed the following (see related tasks for more information):

- You have defined more than one connection to the same server
- You have defined more than one filter pool
- You have enabled Show Filter Pools from the Remote Systems view toolbar

To use filter pools references:
1. In the Remote Systems view, expand the connection where you want to display a filter pool that exists in another connection.

2. Right-click on a file subsystem and select New > Filter Pool Reference > your profile > name of pool.

3. Look under that subsystem again and you will see the filter pool reference.

To delete a filter pool reference, right-click it and select Remove reference. You can also move your filter pools up and down with the right-click menu.

**Related concepts**

Remote System Explorer filters, filter pools, and filter pool references

**Related tasks**

“Configuring filter pools” on page 16

“Creating a second connection to a remote server” on page 11
Chapter 4. Remote System Explorer Profiles

All Remote System Explorer resources such as connections, filters, and filter pools are owned by a profile. Profiles help you manage these resources when you have a lot of connections. The Remote System Explorer creates two profiles when starting up for the first time: a private profile, usually named after the host name of the machine that creates the workspace, and a profile called Team. The intent is to be able to share the Team profile in the future with other members of your team. You can also create your own profiles.

**Note:** due to an internal restriction a profile name cannot contain three consecutive underscore characters at this time.

Profiles contain:
- Connections -- including subsystem properties. User IDs and passwords are not shared.
- Filters, filter pools, and filters pool references.
- Other artifacts associated with a profile.

Profiles can be active or inactive. The Remote System Explorer displays all connections from all active profiles and, within a connection, allows filter pools to be referenced from any active profile. Further, the user actions and compile commands shown in the right-click menu for a remote resource are from all active profiles.

Your private profile cannot be deleted or made inactive.

You can use the Team view to control which profiles display in your workspace by making the profiles active.

**Related concepts**
- Remote System Explorer filters, filter pools, and filter pool references
- Remote System Explorer Connections

**Related tasks**
- Creating a second profile

**Creating a second profile**

You might want to create a second profile for connections and data that belong to a particular version of a software release, and are shared by all team members.

To create a second profile:
1. Make the Team view active by clicking on its tab
2. From the Team view’s menu bar, click the "Create a new profile" button
3. Complete the "New Profile" wizard.

**Note:** due to an internal restriction a profile name cannot contain three consecutive underscore characters at this time.
Related tasks

Deleting a profile

Deleting a profile does not delete any elements on the server. The action only deletes your specific configuration (connections and filters) for that profile. To delete a profile:

1. Make the Team view active by clicking on its tab.
2. Right-click on the profile you wish to delete to bring up its context menu.
3. Select the Delete... operation.

Related tasks

Creating a second profile
You can use the Remote Shell view to run and interact with commands and command shells on universal systems. A universal system includes Windows, Linux, and UNIX system types.

Specifically, use the view to:

- Run commands in a command shell
- Display and interpret the output of a program
- Enter input to a program
- Display and manage different commands and shells from the same view.
  Multiple commands can be run in a single shell (one command at a time per shell), multiple shells may be run on a single system, and multiple systems may be running shells.

Whenever a command shell is launched or a command is run from within Remote System Explorer, the Remote Shell view is used to display the output and provide a way to work with that output.

Related tasks

- Running and viewing commands using the Remote Shell view
- Working with command shells

Running and viewing commands using the Remote Shell view

You can open a shell for your local and remote systems, from the Remote System Explorer,

Opening the Remote Shell view and launching a command shell

In the Remote System Explorer, switch to the Remote Shell view by clicking Window > Show View > Remote Shell from the menu bar. To open a new shell in the Remote Shell view, click the down arrow in the view and select Launch shell. To launch a new shell for another connection requires that an existing shell for that connection is selected in the view. Otherwise, the shell must be launched from the Remote Systems, Remote System Details, or the Remote Shell view.

Working with shells

When the Remote Shell view is open, you can work with shells. A shell that preserves its environment across commands. The environment for all commands in the shell may change in response to your input. For example, if you type "cd .." you change the working directory for that shell.

Viewing output in an editor

You can double-click a line of output to open it in an editor. For example, if you encounter an error while running a command, you can double-click the error and the editor opens the source to the line of code where the parser found a problem.
Closing shells

The Cancel shell toolbar item is enabled when the currently displayed shell or command is active. Press Cancel Shell, to terminate that process. If the shell is active, it cancels the shell before removing it from the view.

Content assist

The Remote Shell view supports content assist. You can press CTRL+space to complete file names or environment variable names while you type commands.

Related concepts

Shells and commands in the Remote Systems view

Related tasks

“Working with command shells”

Working with command shells

In the Remote Systems view, you can launch a shell to perform commands in a specific directory or folder of a remote file system.

To launch a new shell from the Remote Systems view:

1. Expand a connection.
2. Right-click on a file subsystem that supports shells and select Launch Shell.
3. Enter shell commands, such as "ls" or "pwd", in the Command field (just beneath the shell itself).

You can also run commands from locations further down in the remote file system tree, so that you do not need to navigate there from your home directory each time. This option takes the default shell, sets the current directory to the folder that was selected, and invokes a command in that directory.

Note: Each new shell shows up in a separate tab. If more than one shell is running on the same connection, each subsequent shell has a number appended to the connection name.

Related concepts

Shells and commands in the Remote Systems view

Related tasks

Running and viewing commands using the Remote Shell view
Chapter 6. Search for text and files on remote servers

You can search for text strings and files on any remote server or file system, including Linux, UNIX, and Windows systems.

There are three main ways you can search for files and text strings on remote servers, depending on your goal:

- Search for text strings within a file
- Search for text strings and/or files within a folder
- Search for text strings, files, and/or folders within a remote file system

To search for files, text strings, and folders:

1. In the Remote Systems view, expand your iSeries, Linux, UNIX, or Windows connection until you reach the folder, file, or file system that you want to search. Select the containing item by clicking on the item.
2. Right-click and select Search. Or, click Search > Remote from the workbench menu. Or, for the keyboard shortcut, enter CTRL+H. All of these actions will invoke the Search window.
3. In the Remote Search window, click the Remote Search tab if it is not already in focus. You can now search for text strings, files, and/or folders, with the option to use powerful Regular Expressions, in addition normal and variable expressions, such as a*b. See Using search parameters with special characters for more information. Regular Expressions might be most familiar to Linux and Unix users. For more information on Regular Expressions, see [http://en.wikipedia.org/wiki/Regular_expression](http://en.wikipedia.org/wiki/Regular_expression).
   - To search for strings, in the Search string field, enter the string that you want to search for, whether it be from a file, a folder, or an entire file system. Select the Case sensitive or Regular expression check boxes if they apply. Leave this field as an asterisk (*) if you do not want to search for strings. You can use commas to specify more than one type of string to search for. For example, you could enter ".c, *.java, b?a.txt, " and so on.
   - To search for files, in the File name patterns field, enter the name of the file you are looking for. Check the Regular expression check box if this option applies. Leave this field as an asterisk (*) if you do not want to search for files. You can use commas to specify more than one type of folder to search for. You can also click Browse to select file extensions to search for.

Note: You cannot edit the contents of the Folder field; however, you can click the Browse button to browse to and specify another folder. If the Folder field is empty, you need to browse to a particular folder before you can launch the search.

4. Click Search.

The matching strings and/or files display in the Remote Search view. The view updates itself as more matches are found and you can click the Stop button if you want to stop the search process. The view shows the strings and/or files that you searched for, with the matches listed beneath in a tree-view structure. For example, if you searched the file "README.txt" for the string "bin", then the Remote Search results view will get multiple results.

To manipulate the set of search results:
• Right-click the parent items of the tree, in this example, "README.txt", and you can select any of the regular Remote Systems options, for example, Open With, Rename, Properties, and so on.

• Right-click any line beneath the parent search item in the tree:
  – Select Copy to copy the path as you see it to your clipboard.
  – Select Go to to open the file in an editor, which highlights the matching text.
    You can double-click on any line to perform the same action.

Related reference

Using search parameters with special characters

You can use special characters such as ?, *, and \, when searching for files and strings, based on the following rules.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Searches all items.</td>
</tr>
<tr>
<td>abc*</td>
<td>Searches for items that begin with the characters abc, for example, abcd or abctest.</td>
</tr>
<tr>
<td>*abc</td>
<td>Searches for items ending with the characters abc, for example, dabc or testabc.</td>
</tr>
<tr>
<td><em>b</em></td>
<td>Searches for items that have the character b anywhere in the name.</td>
</tr>
<tr>
<td>a*c</td>
<td>Searches for items that begin with the character a and end with the character c.</td>
</tr>
<tr>
<td>&quot;a*&quot;</td>
<td>Searches for items within quotation marks that start with the character a, for example, &quot;a,&quot; &quot;ab,&quot; or &quot;ad.&quot; Note that when you use quotation marks, the specification becomes case sensitive.</td>
</tr>
<tr>
<td>abc?</td>
<td>Searches for four-character items that begin with the characters abc and have a single fourth character, for example, abc?.</td>
</tr>
<tr>
<td>?abc</td>
<td>Searches for four-character items that begin with a single character and end in abc, for example, dabc.</td>
</tr>
<tr>
<td>?b?</td>
<td>Searches for three-character items that have a b in the middle, for example, abc.</td>
</tr>
<tr>
<td>a?c</td>
<td>Searches for three-character items that have the character a and c with a single character in between.</td>
</tr>
<tr>
<td>ab?</td>
<td>Searches for three-character items that start with ab and end in a third single character, for example, abc.</td>
</tr>
<tr>
<td>a* or a?</td>
<td>Searches for characters where the * and ? are interpreted literally, for example, a* or a?. The slash represents an escape character. To use a slash literally, enter \.</td>
</tr>
</tbody>
</table>
Chapter 7. Managing archived files

You can work with archived files and folders in the Remote System Explorer.

Use the Remote Systems view to perform the following actions with archived files:

- **Browse files in an archive**
- **Copying and pasting**
- **Dragging and droppin**
- **Creating**
- **Deleting**
- **Searching for content inside an archive**

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browsing:</td>
<td>To browse and open files in an archive, click the plus sign beside the</td>
</tr>
<tr>
<td></td>
<td>archive to display the contents. Continue to expand folders within the</td>
</tr>
<tr>
<td></td>
<td>archive or double-click any file to open it in the default editor. Save</td>
</tr>
<tr>
<td></td>
<td>files as you normally would and they are saved in the archive. In the</td>
</tr>
<tr>
<td></td>
<td>properties view, note the addition of &quot;#archive#&quot; to the path of the file,</td>
</tr>
<tr>
<td></td>
<td>to indicate how the file exists inside the archive.</td>
</tr>
<tr>
<td>Copying and pasting:</td>
<td>To copy and paste files, or move them from one location to another, right-</td>
</tr>
<tr>
<td></td>
<td>click a file or folder inside an archive and select <strong>Copy</strong> or <strong>Move</strong>.</td>
</tr>
<tr>
<td></td>
<td>(When you select <strong>Move</strong> instead of <strong>Copy</strong>, you delete the file in the</td>
</tr>
<tr>
<td></td>
<td>original location, to move it to a new one.) Using the window that opens,</td>
</tr>
<tr>
<td></td>
<td>you can paste the item to any archived, or unarchived location by expanding</td>
</tr>
<tr>
<td></td>
<td>the tree-view to any specific location, and clicking <strong>OK</strong>. Note that you</td>
</tr>
<tr>
<td></td>
<td>can perform this action across different connections as well. For more</td>
</tr>
<tr>
<td></td>
<td>information, see &quot;Copying and pasting in the Remote System Explorer&quot; on page 26.</td>
</tr>
<tr>
<td>Dragging and dropping:</td>
<td>You can drag and drop files between archives, from an archive to an</td>
</tr>
<tr>
<td></td>
<td>unarchived location, or from an unarchived location into an archive. Expand</td>
</tr>
<tr>
<td></td>
<td>both the original and destination locations in the Remote Systems view,</td>
</tr>
<tr>
<td></td>
<td>click the item you want to move, and drag it with your cursor to the</td>
</tr>
<tr>
<td></td>
<td>new location. Note that you can perform this action across different</td>
</tr>
<tr>
<td></td>
<td>connections as well. For more information, see &quot;Dragging and dropping</td>
</tr>
<tr>
<td>Creating:</td>
<td>To create files and folders inside an archive, or to create a new archive,</td>
</tr>
<tr>
<td></td>
<td>right-click any folder in the archive, or the root level archive itself, and</td>
</tr>
<tr>
<td></td>
<td>select:</td>
</tr>
<tr>
<td></td>
<td>• <strong>New &gt; File</strong> to create a normal file within the archive. You can also</td>
</tr>
<tr>
<td></td>
<td>select the file type to be an archive, whereby you can create an archive</td>
</tr>
<tr>
<td></td>
<td>inside of an archive.</td>
</tr>
<tr>
<td></td>
<td>• <strong>New &gt; Folder</strong> to create a normal folder within the archive. Then</td>
</tr>
<tr>
<td></td>
<td>right-click your virtual folder to create more folders or files.</td>
</tr>
<tr>
<td>Deleting:</td>
<td>To delete a file or folder from inside an archive, simply right-click the</td>
</tr>
<tr>
<td></td>
<td>item and select Delete, or hit the Delete key.</td>
</tr>
<tr>
<td>Searching for content inside an archive:</td>
<td>To search for files within an archive, right-click the archive, select <strong>Search</strong>, and complete the dialog box to specify what kinds of files and folder you want to find. Note that if you begin your search on a normal, unarchived directory that contains an archive, the default behaviour is not to search the archive. You need to check the <strong>Search archive files</strong> checkbox to search for contents inside archives in that directory.</td>
</tr>
</tbody>
</table>
Copying and pasting in the Remote System Explorer

You can copy and paste files not only between files and folders, but between different host systems as well. For example, you can copy a file from one folder on your host to another, or from one type of system to another. You can select multiple files as well. However, there are guidelines for what kinds of items you can and cannot copy and paste. In the Remote Systems view, expand the two connections (that represent the two hosts) until you see the file that you want to copy and the location on the other host where you want to paste the file.

To copy and paste:
1. Right-click the original file to select it and select **Copy**.
2. Navigate through the directories and files until you find the place where you want to paste the file.
3. Right-click on the parent file that contains the files where you want to paste your file, and select **Paste**.

Dragging and dropping items in the Remote System Explorer

You can drag and drop files between different hosts, such as Local, Linux, UNIX, or Windows. Additionally, you can drag and drop items within one view; for example, in the Remote Systems view, or you can drag and drop items between views; for example, from the Remote Systems view to the Remote Systems Details view. When you drag and drop items, you copy, rather than cut, the item that you move. If you want to remove an item completely and put it in another location, drag and drop the item first, and then delete the item from the original location.

To drag and drop files or objects:
1. In the Remote Systems view, expand the two connections (that represent the two hosts) until you see the file you want to copy and the location on the other host where you want to paste the file. Or, open two views that contain the item and the destination.
2. Click the item once to select it, hold down the left mouse button while you drag the item to the desired location, and then release the button.
Chapter 8. Accessing Remote System Explorer preferences

The Remote System Explorer has settings that you can customize in a preference page. The name of the category is Remote Systems and it appears in the tree view of the Preferences window.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default user ID for each system type</td>
<td>Specifies a default user ID for a non-local system type. If you do not set the default user ID at the connection level, then the User ID that you specify here will be used. <strong>Note:</strong> Changing the user ID on the Preferences dialog affects all connections and subsystems that inherit it.</td>
<td>Your local user ID</td>
</tr>
<tr>
<td>Show connection names prefixed by profile name</td>
<td>Select this to display connection names in the Remote System Explorer tree view as <code>profile.connection</code>.</td>
<td>Off</td>
</tr>
<tr>
<td>Show filter pools in Remote Systems view</td>
<td>Select this to show filter pools when expanding a subsystem. When this is not selected, expanding a subsystem will display the filters.</td>
<td>Off</td>
</tr>
<tr>
<td>Show &quot;New Connection&quot; prompt in Remote Systems view</td>
<td>The <strong>New Connection</strong> option is displayed in the Remote Systems view so that you can create a new connection.</td>
<td>Off</td>
</tr>
<tr>
<td>Re-open Remote Systems view to previous state</td>
<td>Select this to automatically open previously expanded connections on start-up.</td>
<td>On</td>
</tr>
<tr>
<td>Use cached information to restore the Remote Systems view</td>
<td>Select this option to use locally cached information instead of connecting immediately if you are automatically opening the previously expanded connections when starting RSE.</td>
<td>On</td>
</tr>
</tbody>
</table>
Chapter 9. Saving passwords for remote systems

When you use the Remote System Explorer, you can save passwords for remote systems on your local PC. The stored passwords are then retrieved whenever a password is required to connect. When you save your password for a particular remote system, you will not be prompted to sign on when you try to connect to that system.

When you first try to connect to a remote system, you will be prompted with a dialog.

To save this password on your local PC:
1. Enter your user ID
2. Enter your password
3. Select Save user ID
4. Select Save password

The next time that you connect to the remote system, you will not be prompted to sign on again.

Note: If you still want to be prompted for your user ID and password, right-click on the subsystem and select Connect....

Where passwords are stored

RSE uses the Eclipse-supplied keyring file to store passwords. This is the same keyring used by other eclipse services such as the Eclipse Team support. By default, this is stored in the configuration area under org.eclipse.core.runtime/.keyring in an encrypted format. The encryption does not require a password itself so anyone using Eclipse is capable of decrypting this file.

Users can choose to store the keyring in a different file, or provide a password for doing real encryption by using runtime options when starting Eclipse as follows:
eclipse -keyring C:/mykeyring.txt -password mypasswd

Even so, encryption is not particularly strong. So if your workstation is not protected you should remove your passwords and not store them in the future.

Adding, changing, and removing stored passwords

You can use the password information page to add, change, and remove stored passwords for remote systems:
1. Select Window -> Preferences
2. Expand Remote Systems
3. Select Passwords

Use the Add, Change, and Remove buttons to manage your password information for remote systems.
Chapter 10. Working with SSL

SSL Overview

Secure-Sockets Layer (SSL) is a communications facility that encrypts all communications between a client and a target system. The DStore communications protocol in RSE supports SSL.

SSL achieves its security by using certificates to authenticate each side of a connection made between two parties. The certificates allow for the certain identification of those parties and for the negotiation of an encrypted channel for communication. The certificates themselves are files whose alteration can be easily detected and whose origin is verified by a trusted certificate authority.

Web browsers use SSL and request SSL certificates from their servers to communicate with on-line stores, banks, and other service providers. These are the same kind of certificates, but are used for a different purpose. A web browser will typically be verifying the identity of the server and will be contacting a certificate authority to do so. RSE users, on the other hand, will typically trust the target system to provide certificates to client systems so that the communications can be encrypted.

Using SSL

Certificates are usually manufactured by a service provider (such as a target system) in concert with a certificate authority. The authority can be any entity that the target system trusts including itself. Certificates are delivered to a client system by the target system when the two are negotiating an SSL connection. When starting a connection to a server, DStore first attempts an SSL connection and then falls back to non-SSL if the SSL one fails. As a client, you don’t need to be concerned with the handling of certificates at all, but you can use the RSE SSL preferences page to manage all your certificates that you have received from the target systems you have connected to in the past.

You reach the RSE preferences page by opening the Preferences for the workbench, expanding the Remote Systems category and selecting the SSL subcategory. There you will see operations that allow you to add certificates, rename them to make them easier to manage, remove them once they have expired, and view their contents. You would typically see one certificate for each target system that you have connected to using SSL.

Setting Up The Server

You set up the DStore server to use SSL by editing the ssl.properties file in the server location. This server names the keystore and its password used for holding certificates generated using the keytool utility from the Java SDK. These certificates are then given to the client during SSL startup so that communications can be encrypted.

The keystore file referenced by ssl.properties can contain several entries but only one is used when a client connects. The entries in the keystore may themselves have passwords, but dstore assumes that these are all the same as the keystore password. It makes sense, therefore, to maintain only one keystore for the dstore
server, that it have only one entry, and that it exist in the same directory as the dstore server. That entry can be a self-signed certificate.

The following command will create a keystore and add a single self-signed certificate to it.

```
keytool -genkey -keystore keystore_file -alias entry_name -storepass d98kMn50sV
   -dname "CN=dstore server, OU=division, O=company, L=city, ST=state, C=region"
```

The command would be entered on a single line. It appears here on multiple lines for readability.

After entering this command you will be prompted to supply a password for the entry itself. You should press enter to take the default which is the keystore password.

One would then edit the ssl.properties file to use this as follows:
```
daemon_keystore_file=keystore_file
daemon_keystore_password=d98kMn50sV
```
Chapter 11. Using RSE and EFS

The Eclipse File System (EFS) is an interface supported by Eclipse that allows Eclipse to use non-local file systems. Many Eclipse components are EFS-aware, that is, they can use resources supplied by EFS as if they were located on a local file system. An EFS Provider is an implementer of this EFS interface and provides a file system support for the resources it exposes. RSE is an EFS provider that allows you to access remote resources from any EFS-aware Eclipse component such as the Java Development Tools.

EFS can take any remote file system available through RSE and its various protocols (like the ssh, ftp and dstore connections) and make it visible as resources in the workspace. By sitting at the heart of the Eclipse resource system, the full power of Eclipse - including source parsers, outline views, content assist and the like - comes to remote files as well.

Since RSE’s raison d’etre is remote access, it solves the problem of logging in to remote systems and keeping credentials in a usable UI.

There are issues, however, with treating remote resources as local ones.

EFS makes the Eclipse workspace more flexible, but components and plugins need to be aware that the resources they work on can now be remote. Work is going on throughout Eclipse to improve their EFS integration and hopefully their performance. For now, however, working with remote resources through RSE and EFS is best done on a fast network with low latency.

Pure RSE/EFS projects (i.e. where the .project file is on the remote system) are currently not supported due to low-level interactions between EFS, the Eclipse platform, and the RSE caching mechanism. Purely remote projects will not open automatically on Eclipse startup. However, one can link lower-level folders of a project to an EFS provider, allowing a project to contain a mix of remote and local resources. Note that team support (such as that provided by CVS) will not synchronize resources linked through an EFS provider at this time.

Using this support you could, for example, set up a Java project from a machine at home and link to files on an account at work. If you makes changes at work, you can come home, refresh the project and everything will be updated and compiled.

The advantages of using linked resources and an RSE-supplied EFS are that the tools that the workbench provides are available directly on the remote source. In addition, since you can edit directly on the remote system there will be no immediate synchronization/merge issues. However, this can lead to problems with update conflicts if the directories on the remote system are shared with others and are quite active. The disadvantages are what you would expect: that you can run into quite slow refreshes of the workspace. Since EFS maps the remote directory tree anytime Eclipse wants to do a refresh it may take several hours. Tools that are not EFS-aware may force these refreshes to happen at odd times which can lead to unpredictable performance.
Appendix. Accessibility features for z/OS Explorer

Accessibility features assist users who have a disability, such as restricted mobility or limited vision, to use information technology content successfully.

Overview

z/OS Explorer includes the following major accessibility features:

- Keyboard-only operation
- Operations that use a screen reader
- Color and typeface preferences

z/OS Explorer uses IBM Installation Manager to install the product. You can read about the accessibility features for IBM Installation Manager in IBM Installation Manager documentation.

z/OS Explorer uses the latest W3C Standard, WAI-ARIA 1.0, to ensure compliance with US Section 508 and Web Content Accessibility Guidelines (WCAG) 2.0. To take advantage of accessibility features, use the latest release of your screen reader and the latest web browser that is supported by z/OS Explorer.

The z/OS Explorer online product documentation in IBM Knowledge Center is enabled for accessibility. The accessibility features of IBM Knowledge Center are described in the Accessibility section of the IBM Knowledge Center help.

Keyboard navigation

You can use keyboard shortcuts to navigate the help system and the product without using a mouse. For more information, see the Keyboard shortcuts for the help system in the product topic in z/OS Explorer documentation.

Interface information

The z/OS Explorer online product documentation is available in IBM Knowledge Center, which is viewable from a standard web browser.

PDF files have limited accessibility support. With PDF documentation, you can use optional font enlargement, high-contrast display settings, and can navigate by keyboard alone.

To enable your screen reader to accurately read syntax diagrams, source code examples, and text that contains period or comma PICTURE symbols, you must set the screen reader to speak all punctuation.

Related accessibility information

In addition to standard IBM help desk and support websites, IBM has a TTY telephone service for use by deaf or hard of hearing customers to access sales and support services:

TTY service 800-IBM-3383 (800-426-3383) (within North America)
For more information about the commitment that IBM has to accessibility, see IBM Accessibility.
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing IBM Corporation North Castle Drive Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing Legal and Intellectual Property Law IBM Japan, Ltd. 19-21, Nihonbashi-Hakozakicho, Chuo-ku Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in any manner serve as an endorsement of those websites. The materials at those websites are not part of the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

Intellectual Property Dept. for Rational Software IBM Corporation Silicon Valley Lab 555 Bailey Avenue San Jose, CA 95141-1003 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

**Copyright license**

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided “AS IS”, without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp. 1992, 2017.
If you are viewing this information in softcopy, the photographs and color illustrations may not appear.

Privacy policy considerations

IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies or other technologies to collect product usage information, to help improve the end user experience, to tailor interactions with the end user or for other purposes. In many cases no personally identifiable information is collected by the Software Offerings. Some of our Software Offerings can help enable you to collect personally identifiable information. If this Software Offering uses cookies to collect personally identifiable information, specific information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable information.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at “Copyright and trademark information” at [www.ibm.com/legal/copytrade.shtml](http://www.ibm.com/legal/copytrade.shtml).

Terms and conditions for product documentation

Applicability

These terms and conditions are in addition to any terms of use for the IBM website.

Personal use

You may reproduce these publications for your personal, noncommercial use provided that all proprietary notices are preserved. You may not distribute, display or make derivative work of these publications, or any portion thereof, without the express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise provided that all proprietary notices are preserved. You may not make derivative works of these publications, or reproduce, distribute or display these publications or any portion thereof outside your enterprise, without the express consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either express or implied, to the publications or any information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of the publications is detrimental to its interest or, as determined by IBM, the above instructions are not being properly followed.
You may not download, export or re-export this information except in full compliance with all applicable laws and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.

Copyright license

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Trademark acknowledgments

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at www.ibm.com/legal/copytrade.shtml.

Adobe and PostScript are trademarks of Adobe Systems Incorporated.

Cell Broadband Engine - Sony Computer Entertainment Inc.

Rational® is a trademark of International Business Machines Corporation and Rational Software Corporation, in the United States, other countries, or both.

Intel, Intel Centrino, Intel SpeedStep, Intel Xeon, Celeron, Itanium, and Pentium are trademarks of Intel Corporation in the United States, or other countries, or both.

IT Infrastructure Library is a trademark of Central Computer and Telecommunications Agency

ITIL is a trademark of The Minister for the Cabinet Office

Linear Tape-Open, LTO, and Ultrium are trademarks of HP, IBM Corp., and Quantum

Linux is a trademark of Linus Torvalds

Microsoft, Windows, and the Windows logo are trademarks or registered trademarks of Microsoft Corporation in the United States, or other countries, or both.
Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and other countries.

UNIX is a registered trademark of The Open Group in the United States and other countries.
Index

A
accessibility features 35

C
connections 5
connect to remote servers 5
Linux, UNIX server 6
remote servers 8

D
dstore servers 2
Linux or UNIX 6
Windows 9

F
filter pools 14
configure filter pools 16
configure references 16
create filter pools 16
filters 13
change filters 15
create filters 15
delete filters 15

L
launch command shells 22

M
manage archived files 25
browse 25
copy and paste 25
create 25
delete 25
drag and drop 25
search 25

P
passwords
add, change and remove 29
save 29
profiles
create profiles 19
delete profiles 20

R
Remote Shell view (continued)
command shell (continued)
work 21
command shells 21
commands 21
content assist 22
Remote System Explorer 1
RSE 1
access RSE preference 27
connection 2
extension 4
installation 1
profiles 19
RSE Perspective 2

S
search
manipulate results 24
remote servers 23
special characters 24
server
install the server code 6
start server 7
share filters 14
SSL
overview 31
use SSL 31
ssl.properties 31
start server
automatically 8
manually 7

T
The Eclipse File System (EFS) 33

U
Universal Systems 5
We appreciate your comments about this publication. Please comment on specific errors or omissions, accuracy, organization, subject matter, or completeness of this book. The comments you send should pertain to only the information in this manual or product and the way in which the information is presented.

For technical questions and information about products and prices, please contact your IBM branch office, your IBM business partner, or your authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any way it believes appropriate without incurring any obligation to you. IBM or any other organizations will only use the personal information that you supply to contact you about the issues that you state on this form.

Comments:

Thank you for your support.
Submit your comments using one of these channels:
  • Send your comments to the address on the reverse side of this form.
  • Send a fax to the following number: 800-555-1213
  • Send your comments via email to: phred@us.ibm.com
  • Send a note from the web page: http://w3-03.ibm.com/ids/page/636

If you would like a response from IBM, please fill in the following information:

<table>
<thead>
<tr>
<th>Name</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company or Organization</td>
<td></td>
</tr>
<tr>
<td>Phone No.</td>
<td>Email address</td>
</tr>
</tbody>
</table>